Doro 8050
This guide is for reference only. The actual device, including but not limited to the colour, size, and screen layout, may vary. The actual device and the items supplied may vary depending on the software and accessories available in your region or offered by your service provider. Your local Doro dealer provides additional accessories. The supplied accessories provide the best performance with your phone.

Note! All illustrations are for illustrative purposes only and may not accurately depict the actual device.
Overview

1. **Headset port**, for standard headset with 3.5 mm phone jack
2. **Earpiece**, for phone calls with the phone by the ear
3. **SIM/SD card tray**
4. **Volume buttons**
5. **Touch display**
6. **Home key**
7. **Microphone**
8. **Front camera**, selfie camera
9. **Proximity sensor**, turns off the touch display when the phone is held by the ear
10. **Power button**, press and hold to turn phone on/off
11. **USB port Type-C**, for battery charging or connection to other device like a computer
12. **Loudspeaker**, for hands-free mode
13. **Second microphone**
14. **Rear camera**
15. **Camera flash/torch**
16. **Assistance button**, must be setup before use, see full manual for more information
17. **Charging cradle** (optional accessory)
# Contents

How to set up your Doro 8050 ............................................................... 1
  Unbox your new phone ................................................................. 1
  Getting started ........................................................................... 2
  Insert SIM card and memory card ............................................. 3
  Charge your phone ................................................................. 4
  Turn on the phone ....................................................................... 6

Get to know your phone ........................................................................ 7
  Screen protection ........................................................................ 7
  Start-up wizard ............................................................................ 7
  Sign in to Google™ ..................................................................... 7
  Android™ and Google™ .............................................................. 8
  Assistive functions ....................................................................... 8
  Touchscreen motion and gestures .............................................. 9
  Sensors ...................................................................................... 10
  Home screen ............................................................................. 10
  Lock screen ................................................................................ 11
  Screen lock .............................................................................. 11
  To use the phone keys ........................................................... 13
  My applications screen ............................................................ 16

Quick and easy way to quiet your phone ....................................... 16
  Status bar .................................................................................. 17
  Notification panel ........................................................................ 17
  Quick settings panel ................................................................... 18
  Enter text ................................................................................... 18
  Capture a screenshot .................................................................. 20
  Connect to the Internet ........................................................... 21
  Battery ..................................................................................... 23

Navigate your phone .............................................................................. 25
  Meet “EVA” – ”Enkel, Vänlig och för Alla” (Swedish) .............. 25
  Call ......................................................................................... 25
  View ....................................................................................... 26
  Send ..................................................................................... 26
  Search .................................................................................... 26
  Add ....................................................................................... 27
  Help ...................................................................................... 27
<table>
<thead>
<tr>
<th>Assistance options</th>
<th>51</th>
</tr>
</thead>
<tbody>
<tr>
<td>My assistance button</td>
<td>51</td>
</tr>
<tr>
<td>Response by Doro</td>
<td>52</td>
</tr>
<tr>
<td>ICE (In Case of Emergency)</td>
<td>52</td>
</tr>
<tr>
<td>The remote help</td>
<td>53</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Google search</th>
<th>53</th>
</tr>
</thead>
<tbody>
<tr>
<td>To use the web browser</td>
<td>54</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Applications</th>
<th>54</th>
</tr>
</thead>
<tbody>
<tr>
<td>Messages</td>
<td>54</td>
</tr>
<tr>
<td>Email</td>
<td>55</td>
</tr>
<tr>
<td>Camera</td>
<td>56</td>
</tr>
<tr>
<td>Handle pictures in the Gallery</td>
<td>57</td>
</tr>
<tr>
<td>Internet (Web browser)</td>
<td>58</td>
</tr>
<tr>
<td>Dock mode</td>
<td>58</td>
</tr>
<tr>
<td>Music</td>
<td>58</td>
</tr>
<tr>
<td>Calendar</td>
<td>59</td>
</tr>
<tr>
<td>Alarm</td>
<td>59</td>
</tr>
<tr>
<td>Timer</td>
<td>60</td>
</tr>
<tr>
<td>My notes</td>
<td>60</td>
</tr>
<tr>
<td>Torch</td>
<td>61</td>
</tr>
<tr>
<td>Calculator</td>
<td>61</td>
</tr>
<tr>
<td>Google apps</td>
<td>61</td>
</tr>
<tr>
<td>The cloud</td>
<td>62</td>
</tr>
<tr>
<td>Location based services</td>
<td>62</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status icons</th>
<th>63</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Safety instructions</th>
<th>64</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network services and costs</td>
<td>64</td>
</tr>
<tr>
<td>Operating environment</td>
<td>64</td>
</tr>
<tr>
<td>Medical units</td>
<td>64</td>
</tr>
<tr>
<td>Areas with explosion risk</td>
<td>65</td>
</tr>
<tr>
<td>Li-Polymer battery</td>
<td>65</td>
</tr>
<tr>
<td>Protect your hearing</td>
<td>66</td>
</tr>
<tr>
<td>Emergency calls</td>
<td>66</td>
</tr>
<tr>
<td>GPS/Location based functions</td>
<td>66</td>
</tr>
<tr>
<td>Vehicles</td>
<td>66</td>
</tr>
<tr>
<td>Protect your personal data</td>
<td>67</td>
</tr>
<tr>
<td>Malware and viruses</td>
<td>67</td>
</tr>
</tbody>
</table>
How to set up your Doro 8050

When you first get your phone, there is a few actions that you need to take before starting to use it.

Unbox your new phone
The first step is to unbox the phone and assess the items and equipment included in the delivery. Make sure to read through the manual so you can familiarise yourself with the equipment and the basic functions. For more information about accessories or other Doro products please visit www.doro.com or contact our Helpline.

- The items supplied with the device and any available accessories may vary depending on the region or service provider.
- The supplied items are designed for this device and may not be compatible with other devices.
- Appearances and specifications are subject to change without prior notice.
- You can purchase additional accessories from your local Doro retailer. Make sure they are compatible with the device before purchase.
- Only use chargers and accessories that have been approved for use with this particular model. Connecting other accessories may be dangerous and may invalidate the phone's type approval and warranty.
Getting started
Before you start using your new phone you may need:

• **nano-SIM card.** To take full advantage of your new smartphone’s capabilities, you should install a SIM card. The SIM card will enable you to place calls or use mobile data to connect to various Internet services. Your mobile service provider will give you a card and the codes needed for it (PIN and PUK) when you buy a mobile contract or a prepaid SIM card. Make sure you get a suitable contract that fit your needs regarding calls and mobile data.

• **Google account.** To be able to fully use your new smartphone you need a Google account. If you don’t have one yet, no worries, as you will be guided through a account setup when starting the phone for the first time. It can however be a good idea to think of a Username and Password as these will be used for many services, such as Gmail, Google Drive, Google Photos and more.

• **Memory card (optional).** From Android 6.0, you can select to use a memory card (microSD) as extended internal memory or as a portable memory.

• **Wi-Fi access.** If you have a Wi-Fi access point available, it’s always good to connect to that to reduce costs for data traffic and possibly increase data speed.
Insert SIM card and memory card

SIM card is not included and memory card is optional and not included

**CAUTION**

Turn off the phone and disconnect the charger before removing the SIM/memory card tray.

Pull out the SIM/memory card tray

Use your fingernail or other similar object, to gently pull out the SIM/memory card tray.

**IMPORTANT!**

Be careful not to damage your fingernails when you remove the SIM/memory card tray.

Insert the card(s)

- Place the nano-SIM card into the correct tray slot to ensure that it can be recognized by the phone. Make sure that the SIM card’s contacts are facing downwards and that the cut off corner is down, as shown. Take care not to scratch or bend the contacts on the SIM card.
- You may also optionally place a memory card in the tray. Make sure that the memory card’s contacts are facing downwards, as shown. Compatible card type: microSD, microSDHC, microSDXC.
- Insert the SIM card tray back into its slot.
This device accepts nano-SIM or 4FF SIM card. Using a modified incompatible SIM card that is thicker than a nano-SIM card may damage the card itself, the card slot and corrupt any data stored on the card.

Use only compatible memory cards with this device. Compatible card type: microSD, microSDHC, microSDXC. Incompatible cards may damage the card itself, the device and corrupt any data stored on the card. Some phones may have a pre-installed memory card. Take care not to scratch or bend the contacts on the memory or SIM card when inserting them into the card tray.

See *External memory*, p.40 for additional info.

**Charge your phone**

While it's possible that your phone will already come with enough charge to be powered on right out of the box, we recommend to fully charge it before first use.

Only use chargers and accessories that have been approved for use with this particular model. Connecting other accessories may be dangerous and may invalidate the phone's type approval and warranty.
A. Insert the small end of the included USB cable into the charging port on the phone.

B. You can also charge the phone using the cradle. Insert the small end of the included USB cable into the charging port on the backside of the cradle and place the phone in the cradle.

C. Insert the other end of the included USB cable into the wall charger that you plug into to a wall socket.

D. You can also plug the included USB cable into a USB port on your computer. Generally charging is quicker if plugged directly into the wall socket.

If the phone is turned off during charging, the phone is still charging. Press the Power button to view charging status.

Save energy
When you have fully charged the battery and disconnected the charger from the device, unplug the charger from the wall socket.
Note! To save power, the screen is locked after a while. Press the Power button to activate the screen, see *Lock screen*, p.11

If the battery is completely discharged, the device cannot be turned on immediately when the charger is connected. Allow a depleted battery to charge for a few minutes before turning on the device.

**Turn on the phone**

Note! When turning on your phone, the installed applications may need to be updated. Application updates requires Internet connection and can take a few minutes. A Wi-Fi connection is preferable. The phone may appear a bit slow during the update.

- Once you've fully charged the device, turn it on by pressing and holding the Power button. Keep it pressed until the phone vibrates and the display lights up.
- Enter your SIM card PIN if requested, then press OK. Tap ✗ to erase.
- Wait for the phone to start.

If the wrong PIN code is entered several times Enter PUK is displayed and you need to enter your PUK code (Personal Unblocking Key). Contact your service provider for more information about PIN and PUK code. See *Change the SIM PIN code*, p.42 for information about changing the PIN code.

**To turn off the phone**

- Press and hold the Power button until the options menu opens.
- In the options menu, tap Power off.
Get to know your phone

Screen protection
Before you start to use your new phone, remove the protection film that covers the device. Please note the helpful directions that is printed on the protection film.

Screen covers and protectors may help you protect your device against damage. Only use screen covers and other protections intended for your device. Third party protection accessories may prevent your device from working correctly by covering sensors, lenses, speakers, or microphones.

Start-up wizard
The first time you start your device, a Start-up wizard helps you to setup basic settings, customise your device and sign in to your accounts, for example a Google™ account.

The device language is normally determined by the inserted SIM card, but you may change the language if you want. All settings presented in the Start-up wizard can also be changed later if you are unsure what to do.

You will also get some quick tutorials of how to handle your phone. Find more tutorials at Help, p.27.

Sign in to Google™

**IMPORTANT!**
You need an Internet connection to use this service. It is recommended to use Wi-Fi connections when available to reduce costs for data traffic. Contact your service provider for detailed subscription costs before activating.

To be able to fully use your new smartphone you need a Google™ Account. One free account gives you access to free Google products like Gmail™, YouTube™, Google Maps™, Google Drive™, Google Photos™ and other Google product. It’s a convenient way to manage your phone’s applications, contacts, calendar events, reminders and more. You can also back up your information in case you should lose your phone. You don't have to use any of the specific Google services like Gmail on a daily basis if you don't want to, and you can add other email accounts to your phone.
Create Google™ account

1. From the Home screen, select 🎯 Play Store.
2. Follow the on-screen instructions to complete the account setup.

**IMPORTANT!**

It is crucial that you remember your Google account username and password. During a factory settings restoration or microSD card-based update, Google's anti-theft mechanism requires you to enter the Google account your phone last logged in to on the startup navigation screen for identity authentication. Your phone can properly power on only after the identity authentication passes. Also, if you have more than one Google account, make sure to enter the details for the relevant account.

**Android™ and Google™**

Your new phone runs on Android™. Android™ is a mobile operating system developed by Google™. It is based on a version of Linux and other open source software, and is designed primarily for touchscreen mobile devices such as smartphones and tablets.

You can find more help regarding Android™ on support.google.com/android/.

Android™ is also associated with a suite of software developed by Google™, called Google Mobile Services (GMS), that are pre-installed on this device. This includes apps such as Gmail, the application store Google Play, the Google Chrome web browser and Google Search app.

You can find more help regarding the apps in Google Mobile Services (GMS) on support.google.com. Select the app you need help with.

**Assistive functions**

Use the symbols to guide you through supporting sections in the manual.

- 🌍 Seeing
- 🎤 Hearing
- ✈️ Handling
- 💖 Safety
Touchscreen motion and gestures

**Tap**
- Tap an item, such as a button or a program icon, to select it or to open it. Tap can be used to select or deselect a relevant tick box in a list of options.

**Double tap**
- Touch the same item twice to zoom in on a map or an image.

**Long press**
- Touch and hold an item on the screen. Some actions, such as to move an icon on the Home screen, begins with a long press.

**Swipe**
- A swipe is when you press your finger to the screen and drag it, the screen moves. Swiping to the left on the Home screen, for example, moves you to the next Home screen. Drag or flick your finger on the screen in the direction you want to go. Think of it as using the left- or right-arrow keys on a computer keyboard. **Flick** means to swipe more quickly on a page, quickly flick your finger on the screen in the direction you want to move.

**Pinch**
- Place two fingers separated on the screen and pinch them together to zoom out of a map. This function is not always applicable.
Zoom
• Place two fingers together on the screen and spread them to zoom in. This function is not always applicable.

Rotate view in maps
• Using two fingers, rotate the map clockwise or counterclockwise. Touch the Compass Pointer icon to reorient the map with north at the top of the screen.

Drag and drop
• Dragging and dropping is a way of moving something – for example, an app on your desktop – from one place to another. To drag, put your finger on an app and hold down. As you move your finger across your screen, the app is dragged across the screen, or across several screens. Place your finger where you want the app to go and release your finger. The app drops.

⚠️ CAUTION
Avoid scratching the touch screen, do not tap it with anything sharp or allow the touch screen to come into contact with water. Do not touch the screen if the glass is cracked or shattered.

Sensors
Your device has sensors that detect light and proximity on the top of the front.
• **Light sensor** to detect light and adjust the brightness of the screen, if set to automatic.
• **Proximity sensor** (**touch sensor**) to detect motions. It can turn the touch screen off during voice calls when your ear is close to the screen to prevent unintentionally activating other functions.

Home screen
The Home screen is your start screen on your Doro 8050, and here you can collect the apps and your favourite contacts that you use most often. You can also set your favourite picture as wallpaper. Use the Google™ search
bar to quickly find what you are looking for. To manage shortcuts on the Home screen see *My widgets*, p.29.

**Go to the Home screen**
- Press the centre oval key or the display icon  

**Lock screen**
The screen turns off and locks when you are not using the phone. The lock screen can show time and date as well as notifications like missed calls or messages.

*Note!* Your phone continues to run while it’s sleeping. Mail is received, social networking updates are made, and so on. Your phone also continues to play music while the screen is locked.

**Activate the screen**
- Briefly press the or the **Power button**.

**Lock the screen**
- Briefly press the **Power button**.

**Screen lock**
The screen lock prevents unwanted actions on the touch screen when you are not using the phone.

**Screen lock settings**
You can change the way that you unlock the screen to prevent others from accessing your personal information.

1. To activate the screen lock or change the type of screen lock, tap  
   Set ➔ Advanced settings ➔ Security & location.
2. Tap **Screen lock**. If you already have a screen lock activated you need to enter the unlock code or pattern.
   Tap to select one of the following:
   - **None** to unlock, tap  or the **Power button**. This option gives no security.
   - **Swipe** to unlock you slide up with your finger. This option gives no security.
• **Pattern** to unlock you trace a pattern with your finger on the screen. This option gives medium security.

**Note!** You can trace over the dots in any order, but you can trace over the same dot only once. The pattern must cover at least four dots.

• **PIN** (default setting) to unlock you type a PIN. A PIN consists of numbers only. Enter at least four numbers, and then enter the password again to verify it. This option gives medium to high security.

• **Password** to unlock you type a password. A password can consist of characters and/or numbers. Enter at least four characters including numbers and symbols, and then enter the password again to verify it. This option gives high security.

• **Fingerprint** to unlock you use your fingerprint to unlock. The fingerprint unlock method requires a **PIN** as well. See more at . This option gives medium to high security.

**IMPORTANT!**

It makes sense to choose a password, PIN code or a pattern that is easy to remember, but try to make it difficult enough so that others can’t guess it. The password, PIN code or pattern screen lock, together with your Google account login is the basis for the anti-theft features on this phone. Enabling a secure screen lock and having a Google account on your phone will make it difficult for a thief or other person getting access to your personal data or even resetting your phone. Keep the secure screen lock information and Google account login stored in a safe place!, see *Reset the phone*, p.39.

**Note!** The available options may vary depending on the screen lock method selected.
To use the phone keys

Home key

- Press the centre oval key/fingerprint sensor or or to return to the Home screen. In the rest of the document we will only refer to .

Note! is only visible if Swipe up on Home button is activated, see Swipe up on Home button, p.14.

is only visible if Swipe up on Home button is deactivated, see Swipe up on Home button, p.14.

- Press and hold to launch Google Now. Google Now is an intelligent personal assistant developed by Google, that is available within the Google search mobile application.

**IMPORTANT!**

You need an Internet connection and a Google account (see, Sign in to Google™, p.7) to use this service. It is recommended to use Wi-Fi connections when available to reduce costs for data traffic. Contact your service provider for detailed subscription costs before activating.

To set up Wi-Fi, see Connect to Internet using wireless networks (Wi-Fi), p.21.

Doro shortcuts panel

Note! This feature needs to be activated before the icon is visible. See Navigation, p.14
Tap in the command bar to open a panel which contains several shortcuts to ease your phone use.

**Back key**
Tap to return to the previous screen, or to close a dialog box, menu, or keyboard.

**Recents key**

*Note!* is only visible if **Swipe up on Home button** is deactivated, see *Swipe up on Home button*, p.14.

- Tap to view recently used applications.
  1. To close an application, swipe up. Tap **Clear all** to close all at once.
  2. To open an application, tap it.
- Double tap to switch to the previous used app.

**Volume keys**

- During a call the volume keys adjusts the call volume.
- From standby the volume keys adjust the media volume.
  Tap the settings icon on the bottom for more sound and volume options.
- To adjust the volume level for music and videos when in an application that plays music or other audio (like games or video players).
- To take picture in Camera mode.

**Navigation**

**Gestures**
These settings can be found via Set ➔ Advanced settings ➔ System ➔ Navigation.

**Jump to camera**
Activate this to quickly open camera by pressing the power button twice. Works from any screen.

**Swipe up on Home button**
With this version of Android there’s a feature called **Swipe up on Home button**. Activate this to swipe up on the Home button to switch apps.
When activated, you no longer have an Overview button on the bottom of your screen.

• Swipe up on 🖼 to enter the multitasking view.
  • Swipe left and right to scroll the list of open apps and tap to select an app.
  • Swipe up to remove apps from the list.
  • Tap the app icon at the top for more options like Split screen view. When the first app is selected, then select the other app to split the screen with.
    Apps in this view are "live" — you can select, copy and paste text while in the multitasking view.

• Swipe right on 🖼 and hold to scroll between apps – release to open the centre app.

• Swipe right on 🖼 quickly and release to just switch to the previous app – the same as a double tap on overview button if gestures are deactivated.

**Double tap to wake**
Activate this to tap the screen twice to wake up device.

**Prevent ringing**
Select what the phone will do when it rings and you press shortcut to prevent ringing, Power & Volume Up together.

• **Vibrate**, to silence the ringing and just vibrate.
• **Mute**, to silence the ringing completely.
• **Do nothing**, to deactivate the shortcut to prevent ringing.

**Doro shortcuts panel**
Activate this to display ••• in the command bar. ••• opens a panel which contains several shortcuts to ease your phone use.

**Soft keys**
Android smart phones like your Doro 8050, as well as most Android applications, feature common icons. Many icons that you see on-screen are actually buttons on the touchscreen. If you don’t see the text, images or information that you want, try to touch the screen or to tap an icon for a pick list or to reach another menu.
To access further options

more options (available in the action bar or in apps).

To enable and disable features and functions

- enabled functions.
- disabled functions.

My applications screen

Application is another word for program or software, a common way to shorten the term application is App. The application screen contains the applications that come pre-installed on your Doro 8050 and any other apps that you choose to install. The applications screen extends beyond the regular screen, so you need to scroll down to view all content.

Open the application screen

- From the Home screen swipe up or tap the arrow .
- Swipe up or down to view all installed applications.

Tip: You can also swipe up or down to open and close the extended Home screen.

Close the application screen

- Tap or .

To install/uninstall applications, see Google™ Play Store, p.43.

Quick and easy way to quiet your phone

- Use the volume keys to adjust the media (music, video) volume.
- Drag the on-screen slider to adjust the sound level.
- Tap the icon on the top switch the phone’s ring mode:
  - Tap to enable ring mode.
  - Tap to enable Silent mode.
  - Tap to enable Vibration mode.
- Tap the settings icon on the bottom for more sound and volume options.
Status bar
The status bar, located at the top of your screen, shows signal strength, ongoing and new applications as well as battery status.

Notification panel
Open the notification panel to view more information about the icons in the status bar, to view your notifications and manage the quick settings like Wi-Fi or Torch.

Open and close the notification panel
To open the notification panel, swipe the status bar down.

To close the notification panel, swipe up twice, or tap twice, or tap to return to the Home screen.

Clear the notifications
• To clear all the notifications, tap Clear all.
• To close one by one, swipe to the left or right.

Notifications on lock screen
All app notifications appear on the lock screen ready for viewing. Not only that, but you can interact with them as well. Depending on the notification in question you can:
• Swipe to dismiss.
• Tap to reply.
• Double tap to go to the relevant app.

Note! To hide sensitive alerts, swipe the status bar down twice and tap Apps & notifications ➔ Notifications ➔ On lock screen ➔ Hide sensitive content or Don't show notifications at all.

Quick settings panel

Use the quick setting buttons
Swipe the status bar down to open the Quick settings panel. Tapping an icon enables you to manage the feature directly within the Quick Settings panel, like toggling the flashlight on and off, or enable/disable the Wi-Fi. Long pressing an icon jumps into the corresponding page within Android’s Settings for full control.

Tip: Swipe down again and use the shortcut ☰️ to reach Advanced settings.

Customise the Quick settings panel
Swiping down once from the top of your phone’s screen shows your notifications as well as a quick access bar containing the first five tiles in your Quick Settings panel.

1. Swipe down from the top of the screen to reveal the Quick settings panel.
2. Swipe down again and tap Edit.
3. Long press on any tile to move, add or remove it from the Quick Settings panel.
4. Tap the ← to exit Edit mode.

Enter text 📝
You can enter text, numbers and other characters using the on-screen keyboard. Select a text field to open the on-screen keyboard. You can adjust your on-screen keyboard in various ways to improve readability.

Activate keyboard
• Tap a text field.
Hide the keyboard

- Tap the icon ↓ or tap ←.

Special characters and numerals

1. Tap ?123 for more characters.
2. Select the desired character or select =\(< to view additional characters.
3. To return, select ABC.

Move the cursor within text

- Tap somewhere in the text to get the marker. Put your finger on the marker to move the cursor within the text. As you move your finger, the marker is dragged over the text. Place your finger where you want the marker to go and release your finger. The marker drops.

Switch between upper case and lower case letters

The Shift-key is found to the lower left of your keyboard. Capitalisation is activated when you start entering text. Capitalisation means writing a word with its first letter in uppercase and the remaining letters in lowercase.

Note! Double tap Spacebar to make a full stop followed by a space.

- Tap Shift key twice to type ALL CAPS.
- to type only lower case letters.
- to type with capitalisation.

Smileys

1. Tap 😊 for a list of smileys.
2. Select the desired smiley.
3. To return, select ABC.

Enter text with word predictions

Start entering text and the dictionary suggests words based on the keys you have selected. When you’re done typing something, you can go back and tap a misspelled or mistakenly autocorrected word. Tap the misspelled or mistakenly autocorrected word to select other possible auto corrections.
This is the easiest way to fix mistakes — if you don’t find the word you wanted, use the Backspace key to erase and type a new word.

**Enter text**

1. Start to type a word, your keyboard may provide predictions as you type. You can tap a predicted word below the entered text to automatically complete it.
2. Tap the **Spacebar** to keep the word you typed and continue with the next word.

**Cut, copy, share and assist**

**Cut, Copy, Share, Select all** and **Paste** are features available when writing an email, text message/box, or basically anywhere.

**Note!** Long pressing on any action bar icon will help to identify them by popping up a text bar describing the action.

1. Touch and hold the text you want to copy.
2. The selected text is highlighted. Move the marker on either end to increase or decrease the highlighted area.
3. When the highlighted area is the size you want, select **Cut** or **Copy**.
4. Touch and hold where you want to paste. The text box **Paste** will be displayed. Tap the text box to paste the text.

**Select keyboard and personalise your keyboard**

You can select to personalise your keyboard, depending on the selected keyboard.

1. Tap **Set** ➔ **Advanced settings** ➔ **System** ➔ **Languages & input** ➔ **Virtual keyboard**.
2. Tap wanted keyboard and make the wanted personalisations to the keyboard.

**Capture a screenshot**

It’s easy and often useful to get a snapshot of your phone’s screen, a screenshot. To view the screenshot, see **Handle pictures in the Gallery**, p.57.

**Take a screenshot**

1. Find the screen you want to get a snapshot of.
2. Simultaneously press and hold the Power button and the Volume minus key.

Note! Pressing and holding the Power button and the Volume Down key is also the key combination that makes the phone to reboot after 8 seconds.

Connect to the Internet
Your smartphone Doro 8050 is just like any other mobile phone - you can make calls and send texts. But you can also access the Internet, send and receive emails, install apps and games, and check your social networking sites, like Facebook and Twitter, for this you need to be connected to Internet. Unless you configured an internet access in the startup wizard, when first starting your phone, here are the instructions on how to do it.

Connect to Internet using wireless networks (Wi-Fi)
Use Wi-Fi to connect your phone to the Internet instead of the mobile network. You may already have Wi-Fi in your home and it’s often available at workplaces. Take advantage of free networks in coffee shops, hotels, trains and libraries. Connecting to the Internet with Wi-Fi doesn’t incur additional data traffic costs, unless you have to pay to get on the wireless network.

1. From the Home screen, tap Set ➔ My internet connection ➔ Wi-Fi.
2. Switch to enable. Available networks are displayed in a list. The networks can be open or secured (🔒).
3. Tap a network and tap Connect.
   If secured, enter the password. Tap Show password to see the password in clear text.
   For more information, contact the relevant network administrator.

Tip: is shown in the status bar when connected.
You can easily turn on and off Wi-Fi from the quick settings in the notification panel. To open the notification panel, swipe the status bar down.

Note! Keep in mind that your phone remembers Wi-Fi networks you connect to. If Wi-Fi is turned on, the phone automatically connects to the network next time you are within reach. Some open networks require you to log in to a webpage before gaining access to the network.
Connect to Internet using mobile data
Use Mobile data to connect your phone to a network provider with a data traffic plan. What that means is that your phone can connect to the Internet anytime it is in range of your operators mobile network, a service you pay for through a monthly data traffic plan. And there may be a limit to the amount of data you can use per month. You can limit your data usage by turning off mobile data. You'll then not be able to access the internet using the mobile network. You can still use Wi-Fi even though mobile data is turned off.

1. From the Home screen, tap Set ➔ My internet connection ➔ My mobile data settings.
2. Switch to enable or disable.

**Note!** You can easily turn on and off Mobile data from the quick settings in the notification panel. To open the notification panel, swipe the status bar down.

**Tip:** Contact your service provider for detailed subscription costs before activating.

Network services and costs
Your device is approved for use on the 4G LTE: 1 (2100), 3 (1800), 7 (2600), 8 (900 MHz), 20 (800), 28 (700) MHz / WCDMA: 1 (2100), 2 (1900), 5 (850), 8 (900) MHz / GSM: 850, 900, 1800, 1900 MHz networks. To use the device, you need a subscription with a service provider.

Using network services may result in traffic costs. Some product features require support from the network, and you may need to subscribe to them.

Some operations and features are SIM card and/or network dependent or dependent on the compatibility of devices and the content formats supported. Some services are subject to a separate charge.

Data roaming On or Off
When you travel with your device and you are switched from your own network operator's network to another, it’s called roaming. The roaming state allows you to be reachable and you can make or receive phone calls regardless of where you are, but it almost always involves a surcharge for using another operator's network. If you need to access the Internet or
other data services using mobile data traffic, then you need to activate data roaming. To limit your data usage when abroad roaming is **Off** as default.

**Tip:** R is shown in the status bar when roaming. Your phone can still access the Internet over the Wi-Fi connection even if you disable roaming.

**Note!** Using data services while roaming can be very costly. Contact your service provider for data roaming rates before you use data roaming.

**Turn Data roaming On or Off**

1. From the Home screen, tap 🔄 Set ➔ 🎯 Advanced settings ➔ Network & Internet ➔ Mobile network.
2. Use the **Data roaming** switch to enable/disable.

**Battery**

**Increase the charging speed**

1. To increase the charging speed, turn the device or its screen off when you charge the battery. Press the **Power button** to view charging status.
2. The device can be used during charging, but it may take longer to fully charge the battery.
3. If the device heats up or the ambient air temperature rises, the charging speed may automatically decrease. This is a normal operating condition to prevent damage to the device.

**Battery saver mode**

Once activated, the battery saver mode, helps to increase battery life. The battery saver is designed to start functioning when the battery level of your phone reaches a certain level. To save battery many features are slowed down, such as: background syncing, vibrations (vibrate on touch will be lost), email and/or message processes and more.

1. From the Home screen, tap 🔄 View ➔ 📁 My phone information ➔ Battery info ➔ Battery Saver ➔ Turn on now.
2. When activated, the colour of the battery in the status bar at the top of the screen turns orange. This lets you instantly know that the mode is activated.
3. To automatically activate power saving mode when the remaining battery power reaches the set level, switch to enable **Turn on automatically**.

4. If needed, adjust the battery level when the battery saver should turn on automatically.

**Note!** You will be prompted to enable the battery saver feature when the battery level reaches the set level. The battery saver feature will turn off automatically when you charge your device.

**Reduce battery consumption**
Here are some tips on how you may extend the phone’s battery power by reducing battery consumption.

- Charge your phone often, preferably every day. Charging does not affect the lifetime of the battery.
- When not downloading data from the Internet, which is power consuming, disable data connections over mobile networks. Data is still transmitted over Wi-Fi.
- Turn off **Wi-Fi** when not in use. Use the notification panel to disable the features.
- Turn off **Bluetooth** when not in use. Use the notification panel to disable the features.
- Deactivate auto-syncing of apps and synchronise your applications manually, like your email, calendar and contacts.
- Use the menu in ☰ View ➔ ☰ My phone information ➔ Battery info ➔ : to see which applications use the most power.
- Decrease the screen brightness, see *Brightness level*, p.30.
- When in areas with no network coverage, turn off your device or activate the **Aeroplane mode**. The device repeatedly scans for available networks which consumes power. See *Aeroplane mode*, p.35.
- The GPS is also quite battery consuming. If you want to stop apps reporting on your location automatically, make sure that Location reporting is off, see *How to turn off GPS location services*, p.63.
- Use Doro original handsfree devices to listen to music. Handsfree devices consume less battery than your device’s own loudspeakers.
- Lock the screen when not in use, press the **Power button** and your display goes to sleep. See *Lock screen*, p.11.
Meet “EVA” – ”Enkel, Vänlig och för Alla” (Swedish) 📞
(Easy, friendly and for everyone)

While Doro smartphones offer as true an Android experience as there is, we take simplicity even further thanks to our intuitive, action-based interface, EVA. EVA makes using a smartphone even easier. It’s like having someone who understands your needs always by your side. Users never need to look around for things they can’t find. EVA simply gives them a few clear choices, and then does what the user wishes based on their response. She’s also the perfect companion when starting up the phone for the first time, guiding the user every step of the way. And because she is designed by Doro, EVA makes the technology fun, available and easy for everyone, whether new to Android, or a long-time user and fan.

Doro's unique telephone menu is action-based and allows you to navigate your phone, by just asking yourself, What do I want to do?

For example, send an email to a contact that is available in your contact book.

1. Tap the 🔄 Send button.
2. What would you like to send? Tap ☉ An email.
3. Tap To contact to select a contact or tap 🔍 to search for a contact.
4. Enter a subject followed by the message text.
5. If desired, tap ⬇️ to access more options.
6. When done, tap ➡️ to send the email.

📞 Call
To call someone.

- A number to enter a phone number, see Calls, p.44.
- A contact to make a call from your contact book. For more info see Calls, p.44 or Contacts, p.47.
- A recent contact to call from the call log, see Call log, p.46
- Voicemail to call your voicemail, see Call settings, p.47.
View
To reach many of the most frequently used apps.

- **My messages** to view messages.
- **My emails** to view emails, create or add an email account, see *Email*, p.55
- **My call history** to view call logs, see *Call log*, p.46
- **My pictures and videos** to view stored images and videos, see *Handle pictures in the Gallery*, p.57
- **My contacts** to see and handle your ICE card (In Case of Emergency), see *Contacts*, p.47
- **My calendar** to see the calendar and your events, see *Calendar*, p.59
- **My notes** to see your notes, see *My notes*, p.60.
- **My location** to go to Google maps and find your location, search for addresses, find your way and more.
- **My applications** to reach your apps, see *My applications screen*, p.16.
- **My phone information** to view information and data about your phone, see *My phone information*, p.37.

Send
To send and share messages, email, pictures and more from your phone.

- **A message** see *Write messages*, p.54
- **An email**, see *Write emails*, p.56
- **A picture or a video** to send a picture or video. To view stored images and videos, see *Handle pictures in the Gallery*, p.57
- **My location** to send your present location.

Search
To find information on the Internet, your way to a place or find out what music you are listening to.
Something on the Internet to search the Internet, see *Internet (Web browser)*, p.58.

Directions, an address, a place to find an address, a place or your way from your current position.

Around me to find useful facilities nearby your current position.

What song is playing now to search the name of that of song/melody that you hear.

Something in my phone to search your phone for contacts, applications and downloaded files.

**Add**
To add new contacts, notes, alarms, events etc.

A contact to create a new contact, see *Add new contact*, p.47.

A note to write a note, see *My notes*, p.60.

An alarm to set an alarm or reminder, see *Alarm*, p.59.

A timer to set timer, see *Timer*, p.60.

An event to book an event and get a reminder at the start time, see *Calendar*, p.59.

An application to add new applications, see *Google™ Play Store*, p.43.

**Help**
Step by step tutorials for you to discover more features of your phone

Tutorials to find helpful tutorials for your phone.

**Set**
To manage the settings of your phone.

My alarms to set an alarm, see *Alarm*, p.59.

My internet connection to activate and set up your Internet connection, see *Connect to the Internet*, p.21.
My other connections to activate and set your connection with The Bluetooth connection or The geolocation options, see The Bluetooth connection®, p.34 or Location based services, p.62.

My homepage to personalise the Home screen with your own wallpaper and widgets, see My Wallpaper, p.29 and My widgets, p.29.

An assistance option to set your assistance button and manage your ICE information (In Case of Emergency) card, see My assistance button ✔️, p.51 or ICE (In Case of Emergency) ✔️, p.52. You can also start remote help from this menu when needed, see My phone information, p.37.

My audio setup for voice calls to set the ringtone, the volume and to manage phone audio settings. You can configure the audio settings with your hearing aid, see My audio setup for voice calls ⌗, p.33.

My messaging apps to enable or disable the display of additional messaging apps in Send/View messages actions.

Advanced settings to set screen’s brightness, sounds volume and vibration on/off, Haptic feedback (vibration on/off when you touch the screen), storing in the phone or on the memory card, the phone’s language, date and time, and the more advanced Android settings.

### Phone settings

**Where to find the settings**

To reach the most common settings for your phone

1. From the Home screen, tap ✍️ Set.

To reach the more and advanced settings for your phone

1. From the Home screen, tap ✍️ Set.
2. Tap ❌ Advanced settings.

**Date & time**

Your phone should already be set to the correct time, date, time format and time zone, these are provided by your network operator. If not, you can set it yourself. Do as follows to reach the settings:
1. From the Home screen, tap Set ➔ Advanced settings ➔ System.

2. Tap Date & time.

3. **Automatic date & time** is activated to automatically update the time, date and time zone.

   **Note!** Switch to disable and manually set time, date and time zone.

### Homepage/display settings

#### My Wallpaper

Wallpaper is the background on the Home screen and on the Lock screen. You can change the wallpaper image into any image, such as a picture you've taken or pre-loaded images.

1. From the Home screen, tap Set ➔ My homepage.

2. Tap My Wallpaper.

3. Tap to select between different themes of backgrounds.

   **Note!** You can set wallpaper both for your home screen and lock screen.

4. Tap an image to select it and confirm with Set wallpaper.

#### My widgets

Widget is a smart feature in Android phones. A widget works like a mini-application or informative window that is also a shortcut to a larger other app on your device. With a Widget you do not have to open the App, the Widget runs directly on the home screen, showing you the information.

Widgets often take the form of on-screen devices such as clocks, event countdowns, auction-tickers, stock market tickers, flight arrival information, daily weather etc..

### Find and add a widget in the menu

You can place even more widgets on the Home screen by following these steps.

1. From the Home screen, tap Set ➔ My homepage ➔ My widgets.
2. Touch and hold to select your widget. Drag and drop the widget to the Home screen.

**Note!** You can also longpress on the home screen and then tap **Widgets** to add a widget.

### My home settings

#### Notification dots
Some apps show a dot, a small marking above the individual app icon, when you get notifications.

1. From the Home screen, tap **Set ➔ My homepage ➔ My home settings ➔ Notification dots.**
2. Tap 🔄 by **Allow notification dots** to enable/disable notification dots.

#### Add icon to Home screen
With this feature enabled, you will automatically get an app icon on your home screen when you install a new app.

1. From the Home screen, tap **Set ➔ My homepage ➔ My home settings.**
2. Tap 🔄 by **Add icon to Home screen** to enable this feature.

### Brightness level
You can adjust the brightness of the screen or totally let the system handle it. The Adaptive Brightness setting lets the system determine the optimal brightness for your smartphone. It’s an automatic setting, just enable it and it will raise or lower the brightness depending on the light in your current environment. This is not only intended to save you time manually altering brightness settings, but also to improve battery life; your smartphone should always be bright enough for your needs but not so bright that it’s consuming more battery than is necessary.

1. From the Home screen, tap **Set ➔ Advanced settings ➔ Display ➔ Brightness level.**
2. Drag the slider to adjust the screen brightness manually. The higher value the brighter the screen.
Tip: When Adaptive brightness is enabled, the screen brightness will automatically adapt to your current environment. Swipe the status bar down to open the Quick settings panel. Swipe down again to reach the brightness slider control.

Screen timeout
You can set the length of time the device waits before turning off the display backlight.

1. From the Home screen, tap Set ➔ Advanced settings ➔ Display ➔ Advanced ➔ Sleep.
2. Tap to set the length of time.

Font size
Adjust the text size to make your screen easier to see.

1. From the Home screen, tap Set ➔ Advanced settings ➔ Display ➔ Advanced ➔ Font size.
2. Drag the slider to adjust the text size.

Display size
Adjust to make items on your screen smaller or larger.

1. From the Home screen, tap Set ➔ Advanced settings ➔ Display ➔ Advanced ➔ Display size.
2. Drag the slider to adjust the text size.

Colour correction
The colour correction setting enables your device to compensate for colour blindness.

1. From the Home screen, tap Set ➔ Advanced settings ➔ Accessibility ➔ Colour correction.
2. Tap by Use colour correction to enable this feature.
3. Tap Correction mode to select colour mode for persons with colour vision deficiency to see things more clearly:
   • Deuteranomaly (red-green) (enhance the perception of green colour, red-green)
   • Protanomaly (red-green)(enhance the perception of red colour, red-green)
• **Tritanomaly (blue-yellow)** (enhance the perception of blue colour, blue-yellow)

• **Monochromacy** (black and white display)

**Note!** Colour correction is currently an experimental feature, so it might not work correctly in all apps.

**Colour inversion**

Colour inversion exchanges colour values. For example, black text on a white screen becomes white text on a black screen.

1. From the Home screen, tap ✨ Set ➔ Accessibility.

2. Tap 🔄 by **Colour inversion** to enable this feature.

**Note!** All colours on your screen are inverted and you may get some pretty odd colour combinations.

Colour inversion is currently an experimental feature, so it might not work correctly in all apps.

**Sound settings**

**Volume**

Adjust volume levels for various sounds on your device.

1. From the Home screen, tap ✨ Set ➔ Sound.

2. Drag the slider to adjust the volume:

   • **Media volume** (for music, videos, games)
   • **Call volume**
   • **Ring volume**
   • **Alarm volume**.

**Tip:** Set **Also vibrate for calls** to feel the vibration even if the ring volume level is low.

You can also press the volume keys to adjust the volume. During a call the volume keys adjusts the call volume and from standby they adjust the media volume.
Ringtone and other tones
Adjust settings for various sounds on your device.

1. From the Home screen, tap Set ➔ Advanced settings ➔ Sound ➔ Phone ringtone.
2. Tap a ringtone to hear the tone.
3. Tap OK to confirm.

Tip: Tap Advanced to see more sounds and other sound settings. You can also press the volume keys on the side of the phone to adjust the volume.

My audio setup for voice calls
If you use a hearing aid or have hearing difficulties when using the telephone in a noisy environment, you can customise the phone's audio settings.

1. From the Home screen, tap Set ➔ My audio setup for voice calls.
2. Tap to select:
   • Normal for normal hearing in normal conditions.
   • Optimised for moderate hearing impairment or use in noisy environment.
   • HAC mode for use with hearing aid.

Hearing aid compatible (HAC)
This telephone is hearing aid compatible. Hearing aid compatibility is not a guarantee that a specific hearing aid will work with a specific telephone. Mobile telephones contain radio transmitters that may interfere with hearing aid performance. This phone has been tested for use with hearing aids, for some of the wireless technologies that it uses, but there may be some newer wireless technologies that have not been tested yet for use with hearing aids. To ensure that a specific hearing aid works well with this telephone, test them together before making a purchase.

The standard for hearing aid compatibility contains two types of ratings:

• M: To use your hearing aid in this mode, make sure that your hearing aid is set to M-mode or acoustic coupling mode, and position the telephone's receiver near the hearing aid's built-in microphone. For the
best results, try using the telephone in different positions relative to your hearing aid—for example, placing the receiver slightly above the ear may result in better performance for hearing aids with microphones positioned behind the ear.

- **T**: To use your hearing aid in this mode, make sure that your hearing aid is set to **T-mode** or telecoil coupling mode (not all hearing aids have this mode). For the best results, try using the telephone in different positions relative to your hearing aid—for example, placing the receiver slightly below or in front of the ear may result in better performance.

### Improve accessibility further

Improve accessibility further with features that make the device easier to use for users who have impaired vision, hearing, and reduced dexterity.

1. From the Home screen, tap **Set ➔ Advanced settings ➔ Accessibility**.

### The Bluetooth connection®

You can connect wirelessly to other Bluetooth® compatible devices such as headsets or other phones.

**Note!** Bluetooth can use a lot of battery power. Don’t forget to turn off when not using.

#### Turn Bluetooth on/off

1. From the Home screen, tap **Set ➔ My other connections ➔ The Bluetooth connection ➔ Connection preferences ➔ Bluetooth-Connection preferences Bluetooth**.
2. Switch to enable.

**Tip:** Your phone has a Bluetooth name that other devices see when you connect them via Bluetooth. You can change that name by tapping on **Device name**. Enter the wanted name and confirm with **Rename**.

#### Pair with other Bluetooth devices

1. From the Home screen, tap **Set ➔ My other connections ➔ The Bluetooth connection**.
2. Tap **Pair new device**.
3. Select the unit that you want to connect to.
4. Tap **Pair** to connect. You may be asked to input a password or to press a button. If prompted, input the password or otherwise acknowledge the connection on your phone or the other device.
5. After you acknowledge the password (or not), the units are connected and communicating. You can begin using the device.
6. If you need more settings for the unit, tap **Previously connected devices**.
7. Tap 🔄 next to the device name.

**Note!** Because the devices are now paired, when you turn on Bluetooth on your device and the other device is on, the connection reestablishes and they'll stay paired until you unpair them.

### Unpair devices

1. From the Home screen, tap 🛑 Set ➔ 📡 My other connections ➔ The Bluetooth connection.
2. Tap **Previously connected devices**.
3. Tap 🔄 next to the device name that you want to unpair.
4. Tap 🚧 Forget.

**Note!** To disconnect you can turn off the other unit or disable Bluetooth on that device.

### Aeroplane mode

In **Aeroplane mode** you can’t make or receive calls, surf the web or download emails, or do anything that requires an Internet connection, this is to prevent disturbance to sensitive equipment. You can still play games, listen to music, watch videos and other content, as long as all this content is saved on your memory card or internal storage.

When you take your phone abroad, you can keep it in flight mode. If you do that, there’s no chance of data roaming charges, and you can still enable Wi-Fi. Enable **Aeroplane mode** when in areas with no network coverage to save battery since the phone repeatedly scans for available networks and this consumes power. You can be notified by alarms, if alarms are activated.
1. From the Home screen, tap 📲 Set ➔ 🔍 Advanced settings ➔ Network & Internet.
2. Tap to activate the Aeroplane mode.

Tip: To enable/disable you can also press and hold the Power button and then select Aeroplane mode in the menu that opens. ✈️ is shown in the status bar when enabled.

Connect the phone to a computer

Connect the phone to a computer and start transferring pictures, music and other file types. All you have to do is connect a USB cable between the phone and computer. From your computer's file explorer, you can drag and drop content between your phone and the computer.

**Note!** You might not be able to transfer some copyright-protected material.

Tip: If default storage location is set to memory card, all photos and videos taken by the phone are stored in the DCIM/Camera folder on the memory card.

Drag and drop content between phone and a computer
1. Connect your phone to a computer using a USB cable.

   **Note!** You might need to wait for the driver to be installed on your computer before you can access the phone.

   Mac users, see [https://www.android.com/filetransfer/](https://www.android.com/filetransfer/).

2. Open the notification panel on the phone by swiping down from the status bar. Tap Android system/Tap for more options. and select File transfer.
3. You are prompted, on the computer screen, to choose what to do when you connect your phone to a computer.

4. Select to open the device and view files in the computer's file explorer.

5. Wait until the phone/memory card appears as external disks in the computer's file explorer.

6. Drag and drop selected files between the phone and the computer.

7. If necessary, also use the **Safe to remove hardware** function on your computer.

8. When done, remove the USB cable.

**Tip:** You can select different connection modes for your phone when connecting to a computer. Swipe down the status bar and tap to select one of the options.

**Note!** When the phone/memory card is mounted to the computer, the phone cannot access the memory card. Some functionality and applications in the phone, such as the camera, may not be accessible. You can transfer files by using a USB cable on most devices and operating systems supporting a USB Mass Storage interface.

**My phone information**
To access device information such as the current software version, battery status or to update device software.

1. From the Home screen, tap ➔ **View ➔ My phone information**.
   - **Battery info** to access information and statistics about battery status and battery usage history.
   - **Storage** check the status of the used and available memory.
   - **Phone status** to check system and software versions and more.
   - **Device update** to check for available software updates.

**Updating your device**
When your device is connected to a Wi-Fi network it's directly updated to the latest software by the firmware over-the-air (FOTA) service.

**Note!** During an update your phone will be temporarily out of service, even for emergency calls. All contacts, photos, settings, etc. will remain safely stored in the phone. Do not interrupt the update process.
IMPORTANT!

We recommend that you always update your device to the latest software version to get optimal performance and the latest enhancements. When a new software is available, a notification message is shown in the status bar, or as a notification. Select it to start downloading. The download time may vary depending on Internet connection.

Backup

Your Google account information is set to back up automatically. Follow below settings to make sure your contacts, system settings, apps, calendar, and email will be restored whenever you set up a new device with that same Google account.

Backup with Google

1. From the Home screen, tap Set ➔ Advanced settings ➔ System.
2. Scroll to and select Backup and make sure that the switch is ON to keep device data safe.

There are many apps that allow you to backup your photos, applications and much more. Some apps even offer cloud storage that allows mobile uploading, and others that allow you to restore your data should you need to. Try searching Play Store, see Google™ Play Store, p.43

Reboot the phone

The reason to perform a reboot might be a persistent problem that is impossible to solve or if your device becomes frozen and unresponsive. This device has an internal battery and therefore the hardware cannot be rebooted by removal of the battery.

• Should you need to reboot the phone, press and hold the Power button and the Volume down key simultaneously for more than 8 seconds or until you feel a vibration to reboot it. After the reboot, the phone will restart automatically.
Reset the phone

IMPORTANT!

Resetting the phone means that most information, such as downloaded and installed applications, accounts, system and application data and settings, will be erased. Be sure to backup any data and files you want to keep before you perform the reset. A backup is a safety copy of information. Carefully read all the text below before you start.

The reason to perform a reset might be a persistent problem that is impossible to solve or if you want to pass the phone to someone else.

Note! Everything added to the phone since you got it will be erased!

Exceptions

- Everything saved on an **SD card** if you have one installed (see *Insert SIM card and memory card*, p.3 and *External memory*, p.40).
- Applications and data by Google™ — if backup is enabled, see *Backup*, p.38.
- Information you have stored in any cloud storages (or on a computer, see *Connect the phone to a computer*, p.36).

IMPORTANT!

Remember the Google account your phone last logged in to. During a reset Google's anti-theft mechanism requires you to enter the Google account your phone last logged in to on the startup navigation screen for identity authentication. Your phone can properly power on only after the identity authentication passes.

Reset the phone

1. From the Home screen, tap 📜 Set ➔ 🔍 Advanced settings ➔ System ➔ Advanced ➔ Reset options:

2. **Reset Wi-Fi, mobile & Bluetooth** to reset all network settings, including Wi-Fi, Mobile data, Bluetooth.. Carefully read the on-screen information, it is **important!**

3. **Reset app preferences** to reset app preferences for:
   - Disabled apps.
   - Disabled app notifications.
   - Default applications for actions.
• Background data restrictions for apps.
• Any permission restrictions.
You will not lose any app data or the app itself, only any changed settings for the app.

4. **Erase all data (factory reset)** to erase all data from your phone's **internal storage**, including:
   • Your Google account.
   • System and app data and settings.
   • Downloaded apps.
   • Music/videos/photos.
   • Other user data.

⚠️ **CAUTION**
This is the last step before ALL data from the device, including Google or other account settings, system and application data and settings will be **permanently** erased.

5. After your phone resets, it will be set back to factory defaults and will be just like it was when it came out of the box.

**Memory and storage**

**Note!** When you update the phone the available capacity may change.

Your phone has different types of memory and storage possibilities.

**Internal storage**
The internal storage is used to store downloaded or transferred content along with your personal settings and data. Examples are alarm, volume and language settings, emails, bookmarks, contacts, calendar events, photos, videos and music.

**External memory**
You can use an external memory card to get more storage space or as a portable memory. There are many different media card standards, use only compatible memory cards. Compatible card type for this device: microSD, microSDHC, microSDXC max 128 GB. SD stands for Secure Digital. Lower-capacity cards store less information. The phone works with or without an SD card installed. We suggest you to use a high speed memory card, especially
if used as extended internal memory. Most applications can read data from a memory card but only certain apps can save files to this type of memory. You can, for example, set the camera application to save photos directly to the memory card.

**Note!** If you insert an external memory, it is recommended you change the default storage location. This allows you to save more files on your phone, like pictures and videos. We recommend that you regularly copy your photos from the phone's internal storage to your computer as a form of backup, see *Connect the phone to a computer*, p.36. These files are found in the DCIM folder on your phone. DCIM stands for Digital Camera Images and it is the default directory structure for digital cameras and for smartphone cameras.

**Free up memory space**
The memory in your device tends to fill up as a result of normal usage. If your phone starts to slow down, or applications suddenly shut down, consider the following:

**Free up space**
When you are surfing the web or using apps on your phone, that will create temporary files stored on your phone in an area of memory called cache. The reason is that the next time you visit the same website or app the phone will load it from cache memory instead of downloading everything again from the server which, take up time and bandwidth. These files will overtime become obsolete and will then be called Junk files. Follow below to delete Junk files and other files.

1. From the Home screen, tap 🔄 View ➙ 📈 My phone information ➙ Storage.
2. Tap Internal shared storage to see the different types of data on your internal memory.
3. Tap Free up space to delete Junk files which are obsolete system and app files.

**Tip:** The Junk files will increase again over time, and you’ll want to perform again.
Delete pictures

• If you use your phone to take a lot of pictures, remember to back them up on your computer every now and again. Not only will this prevent you from losing any photos if anything were to happen to your phone, but it also gives you the opportunity to delete them from your phone and free up space. You can access your pictures by simply plugging your phone into your computer via a USB cable, see Connect the phone to a computer, p.36.

• There are also several services to use if you want to back up your photos – in many cases, automatically. Preloaded to this phone is the Google application, Photos, that supports unlimited storage, photo and video back up, and even create mini-albums for you.

Uninstall applications that you don't use

1. From the Home screen, tap View ➔ My applications.
2. Find the application you don’t use anymore and press and hold the icon.
3. Tap Uninstall.
4. Tap OK to confirm.

Note! Some applications are pre-installed and cannot be uninstalled. All purchases are managed by your Google account. If you want to install a particular app again later on, as long as you are signed in with your original Google account you won’t be charged again for the same app.

Change the SIM PIN code

1. From the Home screen, tap Set ➔ Advanced settings ➔ Security & location ➔ Advanced ➔ SIM card lock.
2. Tap Change SIM PIN.
3. Enter old PIN and tap OK.
4. Enter new PIN and tap OK. Enter new PIN again and select OK once more. When done, SIM PIN changed successfully will appear.

Activate/deactivate SIM card lock

1. From the Home screen, tap Set ➔ Advanced settings ➔ Security & location ➔ Advanced ➔ SIM card lock.
2. At Lock SIM card:
• Switch to activate PIN code. You need to enter the PIN code every time the phone is started.
• Switch to deactivate PIN code.

⚠️ WARNING
If the SIM card is lost/stolen it is unprotected.

**Google™ Play Store**

**IMPORTANT!**

You need an Internet connection to use this service. It is recommended to use Wi-Fi connections when available to reduce costs for data traffic. Contact your service provider for detailed subscription costs.

**Note!** You need to have a Google™ account to use Play Store. Your Gmail account is also your Google Account, so you can use the same Gmail username and password to use other Google products like YouTube, Google Play, and Google Drive.

Browse the available applications and games through different categories or through the lists like Top paid and Top Free. You can also search for a specific application or game.

Some applications need to be purchased. The cost is shown in the application description, the same goes if the application is free. You pay using Google™ Pay, which can be registered when setting up a Google™ account or the first time for a purchase.

**Install applications**

1. From the Home screen, tap Play Store.
2. Find an item you wish to download by browsing categories or by using the search function.
3. Tap the item to view its details, and follow the instructions to complete the installation/purchase.

**Tip:** All downloaded applications can be found in Play Store. Tap ☰, and tap to select My apps & games.
Open an installed application

1. In Play Store, tap and tap to select My apps & games.
2. Select the downloaded application. If needed tap Open.

Update an installed application

1. In Play Store, tap and tap to select My apps & games.
2. You can select to update all applications that needs to be updated, tap Update all, or select a specific application and tap Update and confirm.

Note! You will get a notification whenever there’s an update for any of your installed apps. Please always update to the latest version for best performance and security of the app.

Uninstall applications

1. In Play Store, tap and tap to select My apps & games.
2. Tap to select an application, tap Uninstall and confirm.

Tip: You can also press and hold an app icon and then tap Uninstall.

Calls

Make a call
To call a contact that is currently not available in your contact book, see also Call, p.25.

1. From the Home screen, tap Call.
2. Tap A number.
3. Enter the phone number, you are offered suggestions as you type.
4. Tap to call or tap directly on the suggested contact.

Tip: For international calls, use the international prefix + before the country code. Touch and hold 0 until + is shown.

Answer a call
The phone rings or vibrates to alert you to an incoming call.
**Note!** The phone will not ring if the phone is set to **Vibration mode** or ring/vibrate if the phone is set to **Silent mode**. The phone will not ring, vibrate or even turn on the screen if you have set it to **Do not disturb mode**, see more in *Sound settings*, p.32.

The sound you hear when the phone rings is known as the **ringtone**, see *Ringtone and other tones*, p.33. You can set your phone to play a number of ringtones, for example depending on who’s calling, or you can set a universal ringtone.

1. Tap ☢️ to enable **Silent** mode.
2. Tap 🎧 to enable **Vibrate** mode.
3. The touchscreen display lights up, giving you more information about the call.
4. You now have some options.

**From locked screen**
- **Answer the call** swipe up 📞.
- **Reject the call** swipe down 📞.
- **Silence the ringer** press the volume button (up or down) to silence the ringer.

**From unlocked screen**
- **Answer the call** tap Answer
- **Reject the call** tap Reject
- **Silence the ringer** press the volume button (up or down) to silence the ringer

**End a call**
- Tap 📞 to end.

**Options during a call**

**Volume control**
- Use the side volume keys to adjust the call volume, the selected level is shown on-screen.

**Mute**
1. During a voice call, tap 🎤.
2. To disable, tap once again.

**Keypad (tone sending)**
1. During a voice call, tap 📞.
2. Enter number.
3. To close the keypad, tap ✗.

**Loudspeaker**
1. During a voice call, tap 🎤.
2. Speak clearly into the microphone at a maximum distance of 1 m. Use the volume keys to adjust the loudspeaker volume.
3. To disable, tap 🎤 once again.

**Note!** During a voice call more actions can be available, depending on the region, service provider, model specifications, or software.

**Headset**

**Headset**
- Connect a headset to the headset socket. The internal microphone in the phone is automatically disconnected.

<table>
<thead>
<tr>
<th><strong>CAUTION</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Using a headset at high volume may damage your hearing. Adjust the volume level carefully when using a headset.</td>
</tr>
</tbody>
</table>

**Call log**
1. From the Home screen, select 📟 View ➔ My call history 📞.
2. Tap a number or a contact to:
   - To call, tap 📞.
   - Press and hold a number/contact for more options tapTo call, tap 📞.
   - For more general call log options tap 📟.

**Clear the call log**
1. From the Home screen, select 📟 View ➔ My call history 📞.
2. Tap ⚪ and select Call history.
3. Tap Clear call history to clear all.

Call settings

Lock the screen during calls, call log limitation and more

1. From the Home screen, tap View ➔ My call history ➔.
2. Tap Settings to view the call settings.

Tip: For more help about call settings, see support.google.com/phoneapp/

SOS calls

As long as the phone is switched on, you can always make an SOS call.

1. From the Home screen, tap Call.
2. Tap A number to enter the main local emergency number for your present location.
3. Tap .

Some networks accept calls to emergency numbers without a valid SIM card. Contact your service provider for more information.

Contacts

Add new contact

Your contacts are automatically synced with your Google account (provided that you are logged onto your Google account). To manage synchronisation for your Google account, see Backup, p.38.

1. From the Home screen, tap Add ➔ A contact. You may have to select the account where to save contacts to.
2. Enter contact information and continue to fill in the information you know. Tap More fields to add additional information for the contact.
3. Your new contact is created when you tap Save.

Tip: To hide the keyboard tap and to activate the keyboard simply tap a text field once again.

Manage your contacts

1. From the Home screen, tap View ➔ My contacts.
2. Find and tap the wanted contact to open it.
3. Tap ⭐ to add as favourite contact.
4. Tap Edit contact if you want to change any details.
5. Tap 📸 to add image.
6. Follow the on-screen instructions to complete contact information.
7. Tap Save, when you are done. Your contacts are automatically synced with your Google account (provided that you are logged onto your Google account). To manage synchronisation for your Google account, see Backup, p.38.

Tip: The favourite-contacts are easily found on the top of the contact list.

Add a contact shortcut to the home screen
You can easily add a shortcut widget for a contact to your home screen.

1. From the Home screen, tap 🗄 Set ➔ 🏡 My homepage ➔ My widgets.
2. Find Contacts and select the type of shortcut you want. Touch & hold to place the shortcut where you want it.
3. Find and tap the wanted contact.

Import and export contacts
For more help about importing and exporting contacts, see support.google.com/contacts/.

Note! For best performance, import your SIM contacts and save them to your Google account. By storing your contacts on your Google account, you minimise the risk of losing them in case of a SIM card failure or a lost phone.

How to find the ICE contacts
In case of emergency (ICE) enables first responders to contact your next of kin or any of your stored contacts.

Note! The emergency information must firstly be filled in. See ICE (In Case of Emergency) 💖, p.52.

How to find the ICE contacts from locked screen
1. Swipe to unlock the screen.
2. Tap Emergency ➔ tap Emergency information twice to see the stored ICE information.

3. Tap ✆ to call an ICE contact.

**Note!** Only applies when screen lock method is set to Pattern, PIN or Password, and you must have added your ICE information. To activate the screen lock or change the type of screen lock, see Screen lock, p.11.

**How to find the ICE contacts in the menu**

1. From the Home screen, tap 📱 View ➔ 📞 My phone information ➔ 📏 Phone status.
2. Tap Emergency information to see the stored ICE information.

---

**MyDoro**

**Note!** You need an Internet connection to use MyDoro. It is recommended to use Wi-Fi connections when available to reduce costs for data traffic. Contact your service provider for detailed subscription costs before activating.

🌐 MyDoro is an app that lets a helper manage the settings for Doro’s security services, such as the assistance button, Response by Doro and Smart-Care by Doro on your Doro 8050. It also gives the helper the opportunity to manage some basic settings on the Doro 8050 of the Senior user from an app or the web portal www.mydoro.com, like settings for sound, display and contacts.

There can be many helpers, but the first person that sets up an account and invites the Senior user will be the Admin for the CareCircle.

The CareCircle can be just one helper or a group of helpers that can assist the Senior in various ways.

**Note!** The Doro 8050 user needs to have a MyDoro account to use the service. To be able to use the MyDoro web portal or the app any helpers also need a MyDoro account which they can set up on the web portal. A valid email address is needed to create a MyDoro account.
For the helper(s) 🌿

Create a new account on the web site
The first helper that sets up an account and invites the Senior user will be the Admin for the CareCircle.

2. Click Create account. Follow the on-screen instructions to complete the account setup. You will need to enter a valid email address together with some other personal details.

   **Note!** You should never use the same password for multiple web sites/services.

3. When done, you will receive an email with a link to verify your email address and activate the account. Click on the provided link.

4. Login to the service and start using it by inviting the Senior you want to help, see Add senior., p.50.

   **Note!** To help the Doro 8050 user remotely from their phone the helpers can also install the MyDoro application from Play store or App store. A trusted helper can also get full access to the Doro 8050 by the use of Teamviewer, see The remote help 🤝, p.53.

The My Doro Manager helper application that is available through Play Store or App store is for older phone models and is **NOT** compatible with Doro 8050.

Add senior.
Get the service running by inviting the Senior user you want to help. Always inform the Senior user that you will start the service as it will require actions from the Senior user also.

1. Login to the service and click Add senior.
2. Fill the email address for the Senior user and click Next.
3. You can decide to fill in the details or let the Senior handle it and click Next.
4. Click Confirm when done. An invitation email is now sent to the Senior. See Accept invitation on the Doro 8050, p.51 to finalise and close the CareCircle.
Note! Above can also be done using the app, which can be downloaded via App Store or Google™ Play Store.

For the senior 🌱

Accept invitation on the Doro 8050
1. Open the email received from MyDoro and tap Accept invitation.
2. Fill in the account details if required. Otherwise just enter the Password and Confirm Password you want to use for the service.

Note! You should never use the same password for multiple web sites/services.

You can now close the invitation screen.
3. From the Home screen swipe up or tap the arrow at the bottom of the Home screen and tap the app MyDoro to open it
4. Login to the service.

Assistance options

My assistance button ❤️

IMPORTANT!

You need an Internet connection to use this service. Contact your service provider for detailed subscription costs before activating. The Doro 8050 user needs to have a MyDoro account to use the service. To be able to use the MyDoro web portal or the app any helpers also need a MyDoro account which they can set up on the web portal. A valid email address is needed to create a MyDoro account. Before the assistance button can be used, the user of the Doro 8050 (called Senior) need at least one Helper that has created a MyDoro account and connected with you and by that created a CareCircle.

In order to possibly make everyday safer, the phone has an assistance button on the back. The assistance button makes it easy to contact the helpers that has been defined in the CareCircle.

Make an assistance call
• Press and hold the assistance button on the back of the phone for 3 seconds, or press it three (3) times within 1 second. The assistance
alert is sent after a delay of 5 seconds. In this time you can prevent a possible false alarm by pressing Cancel.

- An assistance alert message is sent to all recipients in the CareCircle.
- A positioning message is also sent to all in the CareCircle.
- The first Helper to respond to the alert will be responsible for the alert and an automatic call to the Senior is initiated.

**IMPORTANT!**

To improve security even further, you can subscribe to the service Response by Doro. See more at Response by Doro ❤️, p.52.

**Response by Doro ❤️**

**IMPORTANT!**

Note that this service is only available on some markets/countries.

Response by Doro is a new, easy-to-use service from Doro, created to give seniors and relatives extra security, every day. By pressing the assistance button on the Doro phone, the user can easily call for help. First the alarm contacts the relatives, and if no relative is able to answer it is automatically sent to one of our alarm centres, where there is staff on duty 24/7. The service is available on selected Doro phones. However, you as relatives can use any iOS or Android smartphone.

Read more at [www.doro.com](http://www.doro.com).

**ICE (In Case of Emergency) ❤️**

In the event of a trauma, it is critical to have this information as early as possible to increase the chances of survival. Add ICE contact to improve your own safety. First responders can access additional information such as medication and next of kin from your phone in case of an emergency. All fields are optional, but the more information provided the better.

**Note!** Your ICE contacts are fetched from your Contact book and you need to make sure that relevant information is stored on each ICE contact.

1. From the Home screen, tap 🔄 Set ➔ ⚠️ An assistance option ➔ ❤️My ICE information.
2. Tap Add information to enter your medical information. Follow the on-screen instructions to complete the ICE-card information.
3. Tap **Add contact** to add and ICE contact.

**Note!** To remove an ICE contact tap ✗ next to the ICE contact.

**The remote help 💌**

Let somebody you trust manage your phone remotely, for example, this can be requested when you contact Doro support. Allow access so they can remotely administrate and transfer files, help you to perform maintenance tasks and help with problems should they occur.

The person performing the remote help must have Teamviewer installed. Teamviewer can be downloaded and installed for many different operating systems at [http://www.teamviewer.com/download/](http://www.teamviewer.com/download/).

**To connect a remote support session**

1. From the Home screen, tap 🔄 Set ➔ 🔄 An assistance option ➔ 🔄 The remote help.
2. Share **Your ID** with your personal tech support to allow remote control. Tap **Send my ID**... to select how to share your ID.
3. Follow the on-screen instructions.
4. To quit TeamViewer, open the Notification panel, swipe the status bar down. Click QuickSupport and tap ✗ in the upper right corner.
5. Confirm with **Close**.

**Note!** All TeamViewer connections are highly encrypted and are thus protected from being accessed by third parties. For detailed technical information regarding connections, security and data privacy in TeamViewer, see the security statement at [http://www.teamviewer.com/en/products/security.aspx](http://www.teamviewer.com/en/products/security.aspx).

**Google search**

**IMPORTANT!**

You need an Internet connection to use this service. It is recommended to use Wi-Fi connections when available to reduce costs for data traffic. Contact your service provider for detailed subscription costs before activating.

**Note!** The available options may vary depending on your device settings.
To use the web browser

1. From the Home screen, tap the Google™ search field Google. **Note!** The first time you are asked if you want to Sign in with your Google account.

2. Tap next to Google to search the Internet, to search you type words, or you can paste text, copied by you.

3. When you start a search on Google, you can find information faster by looking at search predictions. Search predictions are possible search terms you can use that are related to the terms you’re typing and what other people are searching for.

4. Tap to select the best matching search results.
   To go back, tap .

Applications

Applications can be a program or game that you can use on your Doro 8050. Depending on market and service provider, the pre-installed applications can vary. Some applications need Internet access. Contact your service provider for detailed subscription costs before activating. Some applications need to be purchased. The cost is shown in the application description as well as if it is free. Using downloaded and installed applications does not cost anything, except if an Internet connection is needed.

Use Google™ Play Store to download and install all the applications you need.

Messages

Write messages
You can send different types of messages from your phone. Here we will explain how to send a text message, but you can also send other message types from the Send menu.
Tip: Text messages (SMS) are delivered immediately to a device that most of us have with us at all times, a text message also represents a more personal and intimate connection. Most modern smartphones can receive emails (that may be preferable for more formal communications or inquiries) but texting remains simpler and is the only option for those using a more basic cell phone.

You can find more help regarding Messages on support.google.com/messages/.

1. From the Home screen, tap 👈 Send ➔ 📨 A message.
2. Tap 📞 To a number / 📞 To a contact.
3. Enter the phone number, you are offered suggestions as you type or search among your stored contacts.
4. Tap 📨 or tap a suggested contact.
5. Compose your message.
6. When done, tap ➔ to send.

Note! If you choose to add multiple recipients, you may be charged for each recipient. You may also incur additional charges for sending messages when you are roaming. It is recommended to use Wi-Fi connections when available to reduce costs for data traffic.

Messages settings

1. From the Home screen, tap ⬅️ View ➔ 📨 My messages.
2. Tap 📨 ➔ Settings.

Note! Message settings are normally already set and should not need to be altered by you, unless, of course you want to make changes. Some features are network services and you may need to subscribe to them first. For more information contact your service provider.

Email

IMPORTANT!

You need an Internet connection to use this service. It is recommended to use Wi-Fi connections when available to reduce costs for data traffic. Contact your service provider for detailed subscription costs before activating.
**Tip:** Gmail is pre-installed and available under Google that you reach from the Home screen. For more help see support.google.com/mail/. You can of course install other email client apps if you wish.

**Write emails**
Here we will explain how to send an email to a contact that is available in your contact book.

1. From the Home screen, tap 🔄 Send ➔ 📧 An email.
2. Tap 🔄 To contact.
   Alternatively tap 📧 To email address.
3. Tap to select one or several contacts.
4. Compose your text.
5. Enter a subject.
6. Tap to attach files to the email.
7. Tap for more options.
8. When done, tap ➔ to send.

**Read emails**
1. From the Home screen, tap 🔄 View ➔ 📧 My emails.
2. Tap to read an mail.
3. Tap for more options.
   **Note!** Please note that there are two icons for more option.

**Email settings**
1. From the Home screen, tap 🔄 View ➔ 📧 My emails.
2. Tap ➔ Settings.

**Camera**
**Tip:** To get sharp photos, wipe the lens clean with a dry cloth.

**Note!** Do not take photos or record videos of other people without their permission. Do not take a photo or record a video where prohibited or where you may be violating others' integrity.
How to open the Camera

1. From the Home screen, tap Camera.
2. Tap camera button in the app to take a picture.

How to take a selfie

Selfie means to take a picture of yourself. You can use the front camera to take self-portraits.

1. On the camera preview screen, tap to switch to the front camera for self-portraits.
2. Face the front camera. Move the camera around until you find a pleasing pose.
3. When you see your face in the display, tap to take a picture of yourself.

How to record a video

1. On the camera preview screen tap Video.
2. Tap to record a video. Tap to stop recording.
3. Tap Camera to return to camera mode.

Camera settings

1. Tap to access camera settings.
2. Tap to reach and select the different settings. Tap to exit camera settings.

Tip: You can also access your gallery from camera mode, on the camera preview screen, select the thumbnail in the lower left corner.

Handle pictures in the Gallery

View/handle pictures or videos

1. From the Home screen, tap View My pictures and videos.
2. Tap for more options.
3. Select the photo/video to view/play.
4. Swipe to the left or right for the next or previous image/video. Swipe up for details. Tap to get more options.

Tip: For more help see support.google.com/photos/
Internet (Web browser)

**IMPORTANT!**

You need an Internet connection to use this service. It is recommended to use Wi-Fi connections when available to reduce costs for data traffic. Contact your service provider for detailed subscription costs.

To use the web browser

1. From the Home screen, tap 📱 **Search ➔** 🔍 **Something on the Internet.**
2. Enter the word or phrase that you would search and tap 📱.  

**Note!** The first time you are asked if you want to Sign in with your Google account.

You can also enter the search word or phrase directly in the Google bar on the homepage.

**Tip:** For more help see [support.google.com/websearch/](http://support.google.com/websearch/)

Dock mode

When your phone is placed in the charging cradle it will automatically enter what is called dock mode. Dock mode will activate the screen saver that turns your Doro 8050 into a side-table clock unless set otherwise. The screen will dim and turn off after a while. Press the home or power button to wake up the screen.

**Screen saver settings**

1. From the Home screen, tap 📱 **Set ➔** 🛠 **Advanced settings ➔ Display ➔ Advanced ➔ Screen saver.**
2. Tap **Current screen saver** to change screen saver.
3. Tap 🛠 to adjust the settings for the screen saver.
4. Tap **When to start** to set when the screen saver should start.

Tap **Start now** to start the screen saver for testing.

**Music**

You can listen to music and audio files stored on your phone as well as music from internet.
Play music
1. From the Home screen tap Google folder and tap Play Music. The first time you start this app you will be asked if you want to subscribe to Google’s music.
2. Tap Music library to see your available music.
3. Select from different categories like playlists, artists, albums.
   Tip: While you're listening to music you can start and pause the music from the quick settings in the Notification panel. To open the Notification panel, swipe the status bar down. You can also use other features and apps while listening to music.
For more help see support.google.com/googleplaymusic/.

Calendar
Add an event
1. Tap Add an event.
2. Follow the on-screen instructions to complete the event.
3. Tap Save to confirm.
To edit or delete events
1. Tap View My calendar.
2. Scroll or tap Search to find the wanted entry.
   • Tap to edit.
   • Tap Delete to delete the event.
For more help see support.google.com/calendar/.

Alarm
Set alarms
The phone must be powered on in order for the alarm to function properly.
   Tip: Alarms will sound even in silent mode.
1. From the Home screen, tap Add An alarm and follow the on-screen instructions.
**Tip:** To save battery and prevent incoming calls or messages, you can turn on **Aeroplane mode** but still keep the alarm function, see *Aeroplane mode*, p.35.

**To edit or delete alarms**
1. From the Home screen, tap 🔄 Set ➔ ✅ My alarms.
2. To turn on and off switch 🎧.
3. Tap an alarm to edit it.

**Stop or snooze an alarm**
Slide ☞ to:
- 🛌 Snooze, to snooze the alarm for 10 minutes.
- ⏳ Stop, to stop the alarm.

**Timer**
Use the timer to count down from a specified time interval.

**Tip:** The timer will sound even in silent mode.

**Add a timer**
1. From the Home screen, tap 🔄 Add ➔ 🕒 A timer.
2. Set the duration of the timer and tap ➔ to start the countdown.
3. Tap ⏯ to pause and ✅ to stop.

**My notes**
This feature uses Google Keep™.

**Add a note**
1. Tap 🔄 Add ➔ 🖊 A note.
2. Enter required information.
3. For more options, tap ⚙.

**View/edit/delete a note**
1. Tap 🔄 View ➔ 🖊 My notes.
2. Tap the wanted note and edit if needed.
3. For more options, tap ⚙.

For more help see [support.google.com/keep/].
Torch
Swipe down the notification panel and tap `Torch` to turn on the light. Tap again to turn off.

Note! The battery will drain very quickly. Remember to switch off after use.

Calculator
Perform simple calculations.

1. From the Home screen swipe up or tap the arrow at the bottom of the Home screen and tap the app `Calculator` to open it
2. Enter the first number, select an operation (+, -, x, ÷) and enter next number. Repeat if needed.
3. Select `=` to calculate the result.

Tap `del` to delete the latest entry.

Tap `clr` to clear the result.

Google apps

<table>
<thead>
<tr>
<th>IMPORTANT!</th>
</tr>
</thead>
<tbody>
<tr>
<td>You need an Internet connection to use this service. It is recommended to use Wi-Fi connections when available to reduce costs for data traffic. Contact your service provider for detailed subscription costs before activating.</td>
</tr>
</tbody>
</table>

All pre-installed Google™ applications can be found in the Google folder. Depending on the market, the pre-installed applications can vary. To view more app information, access each app’s help menu.

Note! Some apps may not be available or may be labelled differently depending on the region or service provider.

• From the Home screen select `Google` to open the Google™ applications.
  • `Google` quickly search for items on the Internet or on your phone.
  • `Chrome` search for information and browse webpages.
  • `Gmail` send or receive emails via the Google Mail service.
  • `Maps` find your location on the map, search for locations, and view location information for various places.
• **YouTube** watch or create videos and share them with others
• **Drive** store your content on the cloud, access it from anywhere, and share it with others.
• **Play Music** discover, listen to, and share music on your phone. You can upload music collections stored on your device to the cloud and access them later.
• **Play Movies & TV** download videos to watch from Play Store, see *Google™ Play Store*, p.43.
• **Duo** chat individually or in groups with your friends.
• **Photos** search for, manage, and edit all your photos and videos from various sources in one place.

**The cloud**
The cloud is not a physical thing. The cloud is a network of servers, and each server has a different function. Some servers use computing power to run applications or "deliver a service." For example, when you take a picture on your smartphone, it is stored on your phone's internal memory drive. However, when you upload the photos to Instagram, you are uploading it to the cloud.

So remember: The Cloud is a network of servers. Some servers provide an online service, and others allow you to store and access data, like Instagram or Dropbox. Chances are, you encounter the cloud daily. From Google Drive to Evernote, any time you store information without using up your phone's internal data, you're storing information in the cloud.

**Location based services**
LBS stands for Location-Based Service and is a software application for mobile devices that requires knowledge about where the device is located. The service can be query-based and it can provide you with useful information such as “Where is the nearest restaurant?” The service can also be push-based and send you coupons or let you view commute traffic. By law, location-based services must be permission-based. That means that you must opt in (actively say yes) to the service in order to use it.

**Tip:** is shown in the status bar when your phones location is being used by any app.
**English**

**Note!** Turning off location for your device also turns it off for Google apps and other non-Google apps. This means that apps can’t use your phone’s location, and many useful features will be turned off.

**How to turn off GPS location services**

1. From the Home screen, open the notification panel, tap \(\text{Set} \rightarrow\) My other connections \(\rightarrow\) The geolocation options.

2. Switch \(\text{to disable location services.}

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Mobile network" /></td>
<td>Mobile network</td>
<td>Wi-Fi network</td>
</tr>
<tr>
<td><img src="image" alt="Roaming" /></td>
<td>Roaming (in other network)</td>
<td>Bluetooth on</td>
</tr>
<tr>
<td><img src="image" alt="Vibrate mode" /></td>
<td>Vibrate mode</td>
<td>Data transmission: data in (\text{, data out})</td>
</tr>
<tr>
<td><img src="image" alt="Silent mode" /></td>
<td>Silent mode</td>
<td>Error occurred or caution required</td>
</tr>
<tr>
<td><img src="image" alt="Flight mode" /></td>
<td>Flight mode</td>
<td>Alarm active</td>
</tr>
<tr>
<td><img src="image" alt="Google Play Store software updates available" /></td>
<td>Google Play Store software updates available</td>
<td>System update available</td>
</tr>
<tr>
<td><img src="image" alt="Unread email" /></td>
<td>Unread email (in the gmail app)</td>
<td>New text message or multimedia message</td>
</tr>
<tr>
<td><img src="image" alt="GPS activated" /></td>
<td>GPS activated</td>
<td>SIM card not inserted</td>
</tr>
<tr>
<td><img src="image" alt="Headset connected (without microphone)" /></td>
<td>Headset connected (without microphone)</td>
<td>Battery level</td>
</tr>
<tr>
<td><img src="image" alt="Missed call" /></td>
<td>Missed call</td>
<td>Headset connected (with microphone)</td>
</tr>
<tr>
<td><img src="image" alt="Call forwarding on" /></td>
<td>Call forwarding on</td>
<td>Call ongoing</td>
</tr>
</tbody>
</table>

**CAUTION**

If you turn off location-based services apps such as map, navigation, and weather applications cannot access your location information.
### Safety instructions

**CAUTION**
The unit and the accessories can contain small parts. Keep all of the equipment out of the reach of small children. The mains adapter is the disconnect device between the product and mains power. The mains socket outlet must be close to the equipment and easily accessible.

### Network services and costs

Your device is approved for use on the 4G LTE: 1 (2100), 3 (1800), 7 (2600), 8 (900 MHz), 20 (800), 28 (700) MHz / WCDMA: 1 (2100), 2 (1900), 5 (850), 8 (900) MHz / GSM: 850, 900, 1800, 1900 MHz networks. To use the device, you need a subscription with a service provider.

Using network services may result in traffic costs. Some product features require support from the network, and you may need to subscribe to them.

### Operating environment

Follow the rules and laws that apply wherever you are, and always turn off the unit whenever its use is prohibited or can cause interference or hazards. Only use the unit in its normal user position.

Parts of the unit are magnetic. The unit can attract metal objects. Do not keep credit cards or other magnetic media near the unit. There is a risk that information stored on them can be erased.

### Wi-Fi (WLAN)

This equipment may be operated in all European countries.

The 5150 - 5350 MHz band is restricted to indoor use only.

<table>
<thead>
<tr>
<th>AT</th>
<th>BE</th>
<th>BG</th>
<th>CH</th>
<th>CY</th>
<th>CZ</th>
<th>DE</th>
<th>DK</th>
<th>EE</th>
<th>ES</th>
<th>FI</th>
<th>FR</th>
</tr>
</thead>
<tbody>
<tr>
<td>GR</td>
<td>HR</td>
<td>HU</td>
<td>IE</td>
<td>IS</td>
<td>IT</td>
<td>LI</td>
<td>LT</td>
<td>LU</td>
<td>LV</td>
<td>ME</td>
<td>MK</td>
</tr>
<tr>
<td>MT</td>
<td>NL</td>
<td>NO</td>
<td>PL</td>
<td>PT</td>
<td>RO</td>
<td>RS</td>
<td>SE</td>
<td>SI</td>
<td>SK</td>
<td>TR</td>
<td>UK</td>
</tr>
</tbody>
</table>

### Medical units

The use of equipment that transmits radio signals, for example, mobile phones, can interfere with insufficiently protected medical equipment. Consult a doctor or the manufacturer of the equipment to determine if it has adequate protection against external radio signals, or if you have any questions. If notices have been put up at health care facilities instructing you to turn off the unit while you are there, you should comply. Hospitals and other health care facilities sometimes use equipment that can be sensitive to external radio signals.
Implanted medical devices

To avoid potential interference, manufacturers of implanted medical devices recommend a minimum separation of 15 cm between a wireless device and the medical device. Persons who have such devices should:

- Always keep the wireless device more than 15 cm from the medical device.
- Should not carry the phone in a breast pocket.
- Hold the wireless device to the ear opposite the medical device.

If you have any reason to suspect that interference is taking place, turn the phone off immediately. If you have any questions about using your wireless device with an implanted medical device, consult your health care provider.

Areas with explosion risk

Always turn off the unit when you are in an area where there is a risk of explosion. Follow all signs and instructions. There is a risk of explosion in places that include areas where you are normally requested to turn off your car engine. In these areas, sparks can cause explosion or fire which can lead to personal injury or even death.

Turn off the unit at filling stations, and any other place that has fuel pumps and auto repair facilities.

Follow the restrictions that apply to the use of radio equipment near places where fuel is stored and sold, chemical factories and places where blasting is in progress.

Areas with risk for explosion are often – but not always – clearly marked. This also applies to below decks on ships; the transport or storage of chemicals; vehicles that use liquid fuel (such as propane or butane); areas where the air contains chemicals or particles, such as grain, dust or metal powder.

Li-Polymer battery

This product contains a Li-Polymer battery. There is a risk of fire and burns if the battery pack is handled improperly.

![WARNING]

Danger of explosion if battery is incorrectly replaced. To reduce risk of fire or burns, do not disassemble, crush, puncture, short external contacts, expose to temperature above 60° C (140° F), or dispose of in fire or water. Recycle or dispose of used batteries according to the local regulations or reference guide supplied with your product.

Removing/replacing the battery

- To remove/replace the battery, contact an authorised service centre. Please find latest information at www.doro.com.
- For your safety, you must not attempt to remove the battery. If the battery is not properly removed, it may lead to damage to the battery and device, cause personal injury, and/or result in the device being unsafe.
- Doro does not accept liability for any damage or loss if these warnings and instructions are not followed.
Protect your hearing

This device has been tested to comply with the Sound Pressure Level requirement laid down in the applicable EN 50332-1 and/or EN 50332-2 standards.

![WARNING]

Excessive exposure to loud sounds can cause hearing damage. Exposure to loud sounds while driving may distract your attention and cause an accident. Listen to a headset at a moderate level, and do not hold the device near your ear when the loudspeaker is in use.

Emergency calls

**IMPORTANT!**

Mobile phones use radio signals, the mobile phone network, the terrestrial network and user-programmed functions. This means that connection cannot be guaranteed in all circumstances. Therefore, never rely only on a mobile phone for very important calls such as medical emergencies.

GPS/Location based functions

Some products provide GPS/Location based functions. Location determining functionality is provided “As is”. No representation or warranty are made as to the accuracy of such location information. Use of location-based information by the device may not be uninterrupted or error free and may additionally be dependent on network service availability. Please note that functionality may be reduced or prevented in certain environments such as building interiors or areas adjacent to buildings.

![CAUTION]

Do not use GPS functionality in a manner which causes distraction from driving.

Vehicles

Radio signals can affect electronic systems in motor vehicles (for example, electronic fuel injection, ABS brakes, automatic cruise control, air bag systems) that have been incorrectly installed or are inadequately protected. Contact the manufacturer or its representative for more information about your vehicle or any additional equipment.

Do not keep or transport flammable liquids, gases or explosives together with the unit or its accessories. For vehicles equipped with air bags: Remember that air bags fill with air with considerable force.

Do not place objects, including fixed or portable radio equipment in the area above the airbag or the area where it might expand. Serious injuries may be caused if the mobile phone equipment is incorrectly installed and the airbag fills with air.
It is prohibited to use the unit in flight. Turn off the unit before you board a plane. Using wireless telecom units inside a plane can pose risks to air safety and interfere with telecommunications. It may also be illegal.

**Protect your personal data**

Protect your personal data and prevent leakage or misuse of sensitive information

- While using your device, be sure to back up important data.
- When disposing of your device, back up all data and then reset your device to prevent misuse of your personal information.
- Carefully read the permissions screen when downloading applications. Be particularly cautious with applications that have access to many functions or to a significant amount of your personal information.
- Check your accounts regularly for unapproved or suspicious use. If you find any sign of misuse of your personal information, contact your service provider to delete or change your account information.
- In the event your device is lost or stolen, change the passwords on your accounts to protect your personal information.
- Avoid using applications from unknown sources and lock your device with a pattern, password, or PIN.

**Malware and viruses**

To protect your device from malware and viruses, follow these usage tips. Failure to do so may result in damages or loss of data that may not be covered by the warranty service.

- Do not download unknown applications.
- Do not visit untrusted websites.
- Delete suspicious messages or email from unknown senders.
- Set a password and change it regularly.
- Deactivate wireless features, such as Bluetooth, when not in use.
- If the device behaves abnormally, run an antivirus program to check for infection.
- Run an antivirus program on your device before you launch newly-downloaded applications and files.
- Do not edit registry settings or modify the device’s operating system.

**Care and maintenance**

Your unit is a technically advanced product and should be treated with the greatest care. Negligence may void the warranty.

- Protect the unit from moisture. Rain, snow, humidity, and all types of liquids can contain substances that corrode the electronic circuits. If the unit gets wet, you should immediately power off the phone, remove the battery and allow the unit to dry completely before you replace it.
- Do not use or keep the unit in dusty, dirty environments. The unit’s moving parts and electronic components can be damaged.
• Do not keep the unit in warm places. High temperatures can reduce the lifespan for electronic equipment, damage batteries and distort or melt certain plastics.
• Do not keep the unit in cold places. When the unit warms up to normal temperature, condensation can form on the inside and can damage the electronic circuits.
• Do not try to open the unit in any other way than that which is indicated here.
• Do not drop or shake the unit. If it is treated roughly the circuits and precision mechanics can be broken.
• Do not use strong chemicals to clean the unit.
• Do not disassemble, open, crush, bend, deform, puncture or shred.
• Do not modify or remanufacture, attempt to insert foreign objects into the battery, immerse or expose to water or other liquids, expose to fire, explosion or other hazard.
• Only use the battery for the system for which it is specified.
• Only use the battery with a charging system that has been qualified with the system per IEEE-Std-1725. Use of an unqualified battery or charger may present a risk of fire, explosion, leakage, or other hazard.
• Do not short circuit a battery or allow metallic conductive objects to contact battery terminals.
• Replace the battery only with another battery that has been qualified with the system per this standard, IEEE-Std-1725. Use of an unqualified battery may present a risk of fire, explosion, leakage or other hazard.
• Promptly dispose of used batteries in accordance with local regulations.
• Battery usage by children should be supervised.
• Improper battery use may result in a fire, explosion or other hazard.

For devices that utilize a USB port as a charging source, the device's user manual shall include a statement that the device shall only be connected to CTIA certified adapters, products that bear the USB-IF logo or products that have completed the USB-IF compliance program.

The advice applies to the unit, battery, power adapter and other accessories. If the phone is not working as it should, please contact the place of purchase for service. Don’t forget the receipt or a copy of the invoice.

Warranty

This product is guaranteed for a period of 24 months and for original accessories for a period of 12 months (such as the battery, charger, charging cradle or handsfree kit) which may be delivered with your device, from the date of purchase. In the unlikely event of a fault occurring during this period, please contact the place of purchase. Proof of purchase is required for any service or support needed during the guarantee period.

This guarantee will not apply to a fault caused by an accident or a similar incident or damage, liquid ingress, negligence, abnormal usage, non-maintenance or any other circumstances on the user’s part. Furthermore, this guarantee will not apply to any fault caused by a thunderstorm or any other voltage fluctuations. As a matter of precaution, we recommend disconnecting the charger during a thunderstorm.
Please note that this is a voluntary manufacturer’s warranty and provides rights in addition to, and does not affect statutory rights of end-users.

This guarantee does not apply if batteries other than DORO original batteries are used.

### Specifications

<table>
<thead>
<tr>
<th>Network bands (MHz):</th>
<th>850, 900, 1800, 1900</th>
</tr>
</thead>
<tbody>
<tr>
<td>2G GSM:</td>
<td>850, 900, 1800, 1900</td>
</tr>
<tr>
<td>3G UMTS:</td>
<td>1 (2100), 2 (1900), 5 (850), 8 (900)</td>
</tr>
<tr>
<td>4G LTE FDD:</td>
<td>1 (2100), 3 (1800), 7 (2600), 8 (900)</td>
</tr>
<tr>
<td></td>
<td>20 (800), 28 (700)</td>
</tr>
<tr>
<td>Wi-Fi (MHz):</td>
<td>WLAN IEEE 802.11 a/b/g/n, (2412 - 2472) + (5150 - 5875)</td>
</tr>
<tr>
<td>Bluetooth (MHz):</td>
<td>4.2, (2402 - 2480)</td>
</tr>
<tr>
<td>GPS receiver:</td>
<td>GPS/BEUDOU/Galileo/GLONASS</td>
</tr>
<tr>
<td>Operating system:</td>
<td>Android 9 Pie</td>
</tr>
<tr>
<td>SIM card size:</td>
<td>nano-SIM (4FF)</td>
</tr>
<tr>
<td>Dimensions:</td>
<td>153 x 71 x 9 mm</td>
</tr>
<tr>
<td>Weight:</td>
<td>165 g (including battery)</td>
</tr>
<tr>
<td>Battery:</td>
<td>3.85 V / 3000 mAh Li-Polymer battery</td>
</tr>
<tr>
<td>Image format:</td>
<td>BMP, GIF, JPG, PNG</td>
</tr>
<tr>
<td>Video format:</td>
<td>AVI, MP4, 3GP, 3GP2</td>
</tr>
<tr>
<td>Audio format:</td>
<td>WAV, AMR, MIDI, MP3, AAC</td>
</tr>
<tr>
<td>Main camera resolution:</td>
<td>13</td>
</tr>
<tr>
<td>Front camera resolution:</td>
<td>5</td>
</tr>
<tr>
<td>Camera digital zoom:</td>
<td>4x</td>
</tr>
<tr>
<td>Display Size:</td>
<td>5.45”</td>
</tr>
<tr>
<td>Display resolution:</td>
<td>720 x 1440</td>
</tr>
<tr>
<td>RAM:</td>
<td>2 GB</td>
</tr>
<tr>
<td>Internal memory:</td>
<td>16 GB</td>
</tr>
<tr>
<td>External memory:</td>
<td>microSD, microSDHC, microSDXC max 128 GB</td>
</tr>
</tbody>
</table>
Sensors: Accelerometer, Light sensor, Proximity sensor, Compass
USB Interface: USB-C
Headset connector: 3.5mm Stereo
Operating ambient temperature: Min: $0^\circ$ C ($32^\circ$ F) Max: $40^\circ$ C ($104^\circ$ F)
Charging ambient temperature: Min: $0^\circ$ C ($32^\circ$ F) Max: $40^\circ$ C ($104^\circ$ F)
Storage temperature: Min: $-20^\circ$ C ($-4^\circ$ F) Max: $60^\circ$ C ($140^\circ$ F)

Copyright and other notices

Bluetooth® is a registered trademark of Bluetooth SIG, Inc.
vCard is a trademark of the Internet Mail Consortium.
eZiType™ is a trademark of Zi Corporation.
Wi-Fi is a trademark or a registered trademark of the Wi-Fi Alliance.

microSD is a trademark of SD Card Association.
Java, J2ME and all other Java-based marks are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States and other countries.

The contents of this document are provided "as is". Except as required by applicable law, no warranties of any kind, either express or implied, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose, are made in relation to the accuracy, reliability or contents of this document. Doro reserves the right to revise this document or withdraw it at any time without prior notice.

Google, Google Maps™, Gmail, Google Calendar, Google Checkout, Hangouts, YouTube, the YouTube logo, Picasa and Android are trademarks or registered trademarks of Google LLC.

This product is licensed under the MPEG-4 visual and AVC patent portfolio licenses for the personal and noncommercial use of a consumer for (i) encoding video in compliance with the MPEG-4 visual standard ("MPEG-4 video") or the AVC standard ("AVC video") and/or (ii) decoding MPEG-4 or AVC video that was encoded by a consumer engaged in a personal and non-commercial activity and/or was obtained from a video provider licensed by MPEG LA to provide MPEG-4 and/or AVC video. No license is granted or shall be implied for any other use. Additional information including that relating to promotional, internal and commercial uses and licensing may be obtained from MPEG LA, L.L.C. See www.mpegla.com. MPEG Layer-3 audio decoding technology licensed from Fraunhofer IIS and Thomson.

Other product and company names mentioned herein may be the trademarks of their respective owners.
Any rights not expressly granted herein are reserved. All other trademarks are property of their respective owners.

To the maximum extent permitted by applicable law, under no circumstances shall Doro or any of its licensors be responsible for any loss of data or income or any special, incidental, consequential or indirect damages howsoever caused.

Doro does not provide a warranty for or take any responsibility for the functionality, content, or end-user support of third-party apps provided with your device. By using an app, you acknowledge that the app is provided as is. Doro does not make any representations, provide a warranty, or take any responsibility for the functionality, content, or end-user support of third-party apps provided with your device.

**Content copyright**

The unauthorised copying of copyrighted materials is contrary to the provisions of the Copyright Laws of the United States and other countries. This device is intended solely for copying non-copyrighted materials, materials in which you own the copyright, or materials which you are authorised or legally permitted to copy. If you are uncertain about your right to copy any material, please contact your legal advisor.

**Open source licenses**

You are entitled to receive a copy of the source code of software licensed under an open source license that gives you the right to receive the source code for that software (for example GPL or LGPL) to you on an appropriate media, against an administrative fee covering Doro AB’s cost for handling the distribution and costs for media. Please direct such request to Doro AB, Open Source Software Operations, Jorgen Kocksgatan 1B, SE 211 20 Malmö, Sweden. To be valid, such a request must be made within three (3) years from the date of the distribution of this product by Doro AB, or in the case of code licensed under the GPL v3 for as long as Doro AB offers spare parts or customer support for this product model.

**Hearing aid compatibility**

**Note!** For hearing aid compatibility, turn off Bluetooth connectivity.

This phone is hearing aid compatible. Hearing aid compatibility is not a guarantee that a specific hearing aid will work with a specific phone. Mobile phones contain radio transmitters that may interfere with hearing aid performance. This phone has been tested for use with hearing aids, for some of the wireless technologies that it uses, but there may be some newer wireless technologies that have not been tested yet for use with hearing aids. To ensure that a specific hearing aid works well with this phone, test them together before making a purchase.

The standard for hearing aid compatibility contains two types of ratings:

- **M**: To use your hearing aid in this mode, make sure that your hearing aid is set to "M-mode" or acoustic coupling mode, and position the phones receiver near the hearing aid’s built-in microphone. For the best results, try using the phone in different positions relative to your hearing aid—for example, placing the receiver slightly
above the ear may result in better performance for hearing aids with microphones positioned behind the ear.

- **T**: To use your hearing aid in this mode, make sure that your hearing aid is set to "T-mode" or telecoil coupling mode (not all hearing aids have this mode). For the best results, try using the phone in different positions relative to your hearing aid—for example, placing the receiver slightly below or in front of the ear may result in better performance.

Your device meets the M3/T4 level rating.

**Specific Absorption Rate (SAR)**

This device meets applicable international safety requirements for exposure to radio waves. Your mobile device is a radio transmitter and receiver. It is designed not to exceed the limits for exposure to radio waves (radio frequency electromagnetic fields) recommended by international guidelines from the independent scientific organization ICNIRP (International Commission of Non-Ionizing Radiation Protection).

The radio wave exposure guidelines use a unit of measurement known as the Specific Absorption Rate, or SAR. The SAR limit for mobile devices is 2 W/kg averaged over 10 grams of tissue and include a substantial safety margin designed to assure the safety of all persons, regardless of age and health.

Tests for SAR are conducted using standard operating positions with the device transmitting at its highest certified power level in all tested frequency bands. The highest SAR values under the ICNIRP guidelines for this device model are:

**Head SAR:** 0.52 W/kg

**Body SAR:** 1.25 W/kg

During normal use, the SAR values for this device are usually well below the values stated above. This is because, for purposes of system efficiency and to minimize interference on the network, the output power of your mobile device is automatically decreased when full power is not needed for the call. The lower the power output of the device, the lower its SAR value.

This device meets RF exposure guidelines when used against the head or when positioned at least 0.5 cm away from the body. When a carry case, belt clip or other form of device holder is used for body-worn operation, it should not contain metal and should provide at least the above stated separation distance from the body.

The World Health Organization (WHO) has stated that current scientific information does not indicate the need for any special precautions when using mobile devices. If you are interested in reducing your exposure, they recommend you reduce your usage or use a hands-free accessory to keep the device away from your head and body.

**Correct disposal of this product**

(Waste Electrical & Electronic Equipment)

(Applicable in countries with separate collection systems)
This marking on the product, accessories or manual indicates that the product and its electronic accessories (e.g. charger, headset, USB cable) should not be disposed of with other household waste. To prevent possible harm to the environment or human health from uncontrolled waste disposal, please separate these items from other types of waste and recycle them responsibly to promote the sustainable reuse of material resources. Household users should contact either the retailer where they purchased this product, or their local government office, for details of where and how they can take these items for environmentally safe recycling. Business users should contact their supplier and check the terms and conditions of the purchase contract. This product and its electronic accessories should not be mixed with other commercial wastes for disposal. This product is RoHS compliant.

Correct disposal of batteries in this product

(Applicable in countries with separate collection systems)

The marking on the battery, manual or packaging indicates that the battery in this product should not be disposed of with other household waste. Where marked, the chemical symbols Hg, Cd or Pb indicate that the battery contains mercury, cadmium or lead above the reference levels in EC Directive 2006/66. If batteries are not properly disposed of, these substances can cause harm to human health or the environment.

To protect natural resources and to promote material reuse, please separate batteries from other types of waste and recycle them through your local, free battery return system.

Declaration of Conformity

Hereby, Doro declares that the radio equipment type DSB-0230 (Doro 8050) is in compliance with Directives: 2014/53/EU and 2011/65/EU including delegated Directive (EU) 2015/863 amending Annex II. The full text of the EU declaration of conformity is available at the following internet address: www.doro.com/dofc.